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Server baserede Excel
regneark, data visualisering,
Report Center, Bl webparts

Business
. Intelligence

Collaboration

Platform

Services
Blanketter, LOB actions,
workflow

Business
Processes

Workspaces, Mgmt,
Security, Storage,
Topology, Site Model

-

Search

Integreret dokumenthandtering
og arkivering, samt web content
management med workflow og
politikker (internet, intranet og
extranet)

ECM funktionalitet i SharePoint platformen

Dokumenter/opgaver/kalender,
blogs, wikis, e-mail integration,
offline dokumenter/lister.

Enterprise portal skabelon, "My
Site”, social networking, privacy
control, content targeting og
aggregering

Enterprise skalerbarhed,
kontekstuel relevans, person-
og forretningsdata- sggning.
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My |~ Send =  Handlinger - Indstillinger -

« SharePoint indeholder B S

Ny mappe

dokumentbiblioteker, -
der er intelligente Delte dokumenter

Del et dokument med teamet ved at tilfaje det i dette dokumentbibliotek.

| I Iap per d er My - | Send - | Handinger ~ | Indstlinger ~

|E|_] GetOr?anized - Document template configuration 13-05-20(

i HOIder Styr pé dOkument oy zueitt;:;ized-Hu-.x-togetarganized!mw 13-05-20(
VerS|Onerne Og tl”adelser GetOrganized setup guide - simple | M _| 13-05-200

Vis eqenskaber

- Kan facilitere "overvagning” 3| Rt s

3_3 Administrer tiladelser

- H @) I d er Styr p é d O ku me nt B Rediger i Microsoft Office PowerPoint

¥ slet

skabeloner

_ﬁ Tiek ud

- ..0g kan patrykke workflows for e
dokumentet
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N
3. scenarie 4. scenarie
ESDH system MOSS med workflows

ESDH system med
workflows

1. scenarie 2. scenarie

Filserver (med MOSS med anvendelse
navnekonventioner og af status metadata (facet
struktur) plan)
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Kontrol omkring dokumentet




.. Facet planer (definition af metadata) skaber
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HomMe = UEITE doKUMenTEr = LETUrganizeda setlup guiae - simple = HEedlger element

Delte dokumenter: GetOrganized setup guide -

XK slet element | 7 Stavekontrol...

Facet 1: Grundregistrering

Facet 2: Kategorisering

Status

Facet 3: Processtyrende data Ansvarlig

Oprettet k. 13-05-2008 12:37 af Administrator
Sidst eendret ki, 13-05-2008 12:37 af Administrator
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« Kan man placere alle dokumenter i et
dokumentbibliotek — eller skal man anvende
mange “sites”?

Informations Arkitekturen (IA) er meget teet

bundet til teknik og forstaelse af SharePoint’s

» »

begreber som "site collections”, "sites” og
"content databaser” er afggrende for (teknisk)
succes

Hvis en |A Ikke udarbejdes med respekt og
skelen til disse, vil SharePoint ikke performe
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Strategi 1: Alt i én Strategi 2: Fordel pa sites

Indhold i databasen vil vokse og vokse Indhold i databasen vil vokse og vokse efterhanden
efterhndnden som dokumentmaengden som dokumentmeaengden gges — men idet indholdet
ages — og kan ikke splittes ud pa flere er fordelt i mange biblioteker kan det ogsa fordeles

indholdsdatabaser da alt indhold er hensigtmaessigt i indholdsdatabaser

bundet (for bestandigt) til den som

indeholder dokumentbiblioteket

Dokumentcenter Site 1 Site 2

Dokumentbibliotek Dokumentbibliotek Dokumentbibliotek

™~

Indhold i SharePoint f ?j/

Indholds databaser — anbefales: ~ 100Gb*




Digitalen Fordele og ulemper ved anvendelse af
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Fordele Ulemper

* Brugerne skal kun kende et » Det skalerer ikke — alt indhold
sted | SharePoint bliver placeret i én content

En rig datamodel med statte database

lister kan anvendes | metadata Oftest etableres nogle

Man kan modg filtrerede dokumentoversigter
sagsbegreb vet 8 0 som ikke slar igennem i Office

dokumenter til en

System opdateringer er
nemme at gennemfgre

Fare! Dette er den nemme Igsning, men pa sigt vil
modellen fgre til problemer..




Digitalen Fordele og ulemper ved anvendelse af
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Fordele Ulemper

» Det skalerer — det er muligt at « Det kan veere vanskeligt at
fordele indhold | mange finde frem til de rette sites
content database ma bero pa sggning

Hvis indhold pa en "sag” "site directories”

begreenses til | eller bero pa at brugerne
site — sa passe Bep, husker links via "mine links”

pakken / Ing anvendelsen
€ gaende i

Tvaergaende indgang til
oplysningerne er vanskelig at
etablere teknisk




.. Taenk anvendelse og struktur sammen med
Digitalen

i i Office pakken — kontekst er alt afggrende

| Document Management

Home
Open site in browser

M85 2

3

‘EI GetOrganized setup guide - simple. ppt
(Currently Open Document)
IE—IJ GetOrganized - How to get organize.., ! HEw

*. MHEW

IE—IJ GetOrganized - Document template ...

Dokumenthandterings panelet i
Office 2003/2007 viser dokumenter i ) Add new document...
det dokumentbibliotek, hvor (32 Addnew folder...
dokumentet er placeret og genve; til o At otdoaments..
det site som indeholder det

Get Updates Options. ..

Last updated: 13-05-2003 20:49
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Digitalen Anvend 3. parts produkter

« MOSS er en platform

 Det perfekte system KAN etableres pa
MOSS ved udvikling og konfiguration,
spgrgsmalet er altid — hvor meget?

 Mange komponenter findes som 3. parts
software — fa systemer
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Scannings
integration og
produkter

* 3. parts plug-ins
til email/ikke
Office
programmer

* Printer/scannings
produkter

Omrader hvor MOSS funktionalitet og 3. parts
produkter tilsammen tilvejebringer fuld ECM

CAPTURE

Handtering og workflows

* MOSS approval/review workflows

* 3. parts komponenter til workflow
modellering og supplerende actions
sa BPM flows kan understgttes

Lagring og modellerings
produkter

* MOSS dokument biblioteker
* 3. parts komponenter til IA og
skalering

Publicerings
veerktgjer og
transformation
Bevaring

* MOSS

Conversion
* MOSS Recordscenter Services

* 3. parts arkivering « 3. parts PDF

eksport/import komponenter mf.
funktioner




. . Omrader hvor man typisk udvikler funktionalitet
Digitalen .-
Forum for it-pro SpeCIfI kt

Integrationer til andre stamdata systemer
via BDC eller custom fields

Specifikke formularer

Sign-off funktionalitet

Autorisations funktionalitet | saerlige
tilfeelde




Omrader hvor man typisk supplerer med 3.

Digitalen
gForum for it-pro parts ko m ponenter

Specielle webparts som indfrier et
praesentations behov

Specielle felt typer*) eller liste templates

Plug-ins til klient programmer for
SharePoint integration

Administrative programmer til SharePoint
vedligehold (backup/restore) eller
discovery

Capture og publiceringsveerktgjer




Digitqlen Starre platforms veerktgjer

« GetOrganized (www.getorganized.net) —
"samle vejledning” til SharePoint (IA) og
system veerktgj der indfrier strateqi 2,
emails | SharePoint mm.

Nintex (www.nintex.com) — supplerende
workflow engine til SharePoint,
webbaseret SharePoint Designer for
workflows*)
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Digitqlen Det tekniske princip i1 stgrre ECM lgsninger

Best practice er — veelg strategi 2

En portal indrettes gerne ved
udgangspunkt | en standard
"samarbejdsportal” som indrettes med
sags- og dokumenthandtering for gje

Sites = sager

3. parts komponenter som faciliterer
modellering og flows




Digitalen Alle elementer af ECM kan handteres pa MOSS
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Capture: mit
websted anvendes
til medarbejderens
"kladde” dokumenter
og kopieres herfra til
sager

Deliver: Sag og find
materiale i lager

Sitecollection 1

-

Store: En oversigt over de
sager som dokumenterne
placeres pa — enten emne eller

opgave/projekt opdelt

Capture:

Dokumentcenter

anvendes — men kun til
at opsamle dokumenter
til distribution/

Store/Manage:
De enkelte sager
indeholder
dokumenterne der
harer til sagen. Sites
fordeles i site
collections

Sitecollection 2

fordeling til sager.

Preserve: Enten lader

man indholdet blive

Sitecollection 3

T

liggende i de enkelte
sager eller ogsa arkiveres
indhold i records center..

Sitecollection 4 /




i Dokumenter kan distribueres rundt 1 222=F
lgitalen portalen ved anvendelse af "flyt
funktion” eller "send til” (kopi)

=

E_“& | Ny virksomhedsprazsentation

@'ﬂ Test page1 Vis egenskaber 2 iyt dolcument — Webpage Diolog
&) Fiyt dokument
Rediger egenskaber D ki arvendes t a

Administrer tilladelser et a0 | 1 Usts mine saper

B& U

Rediger i Microsoft Office Word| ™ e
Slet i
Send il

Konverter dokument
Tiek ind

Slet udtjekning

Versionshistorik
Arbejdsprocesser
Flyt / kopier

Giv mig besked

L @b il

| Lov forslag om sorte bokse [ty 14-05-2008 10:34

MUS template I My Vis egenskaber 14-05-2008 10:34
Madeindkaldelse - udvalgsmede n{ 53 | Rediger egenskaber 14-05-2008 10:34
Madeindkaldelse - udvalgsmgde n 1;3 Administrer tiladelser 14-05-2008 10:34
Modeindkaldelse - udvalgsmade nf 2] Rediger i Microsaft Office Word 08 10:34

Orientering til trafikministeriep) Slet 14-05-2008 10:34
Send til _‘F Anden placering

Spg Webstedshandlinge|

Home = Dokumentcenter > Dokumenter = Lov forslag om sorte bokse > Kopier

Kopier: Lov forslag om sorte bokse.doc

Brug denne side til at kopiere et element til et andet dokumentbibliotek.

Destination

Angiv en destination og et finavn ti kopien. estinationsdokumentbibliotek eller destinationsmappe (Klik her for at afprevelT
Destinationen skal vaere en URL-adresse til et
SharePoint-dokumentbibliotek.

|'|c:stest.natc:ornpany.com}'oversigtﬁsag%20 1/Delte%:20dokumenter

Filriavrreh

Bemeerk, at du kopierer den udtjekkede version af
dokumentet. |L0»r forslag om sorte bokse




CAPTURE

S Capture processen — kan omfatte
Forum for i pro emails med 3. parts produkter eller
brug af "email enabled” biblioteker i

MOSS

W e [Sgl'l@Featura Requests [@Home'WORKSMARTi Ny... % | @ GetOrganized contacts confi.. l ' office 2007 icons steimicras. . -8 v |k Page v (0 Tooks ~

CMS > WORKSMART: Myt samarbejdssystem for hele organisationen (CMS-2008-00009) Welcome NCDMZ\mek ~ | My Site | My Links = @ i

/,I getorqanj_%gg WORKSMART: Nyt samarbejdssystem for hele organisationen (CMS-2008-00009) p

Alle sager Site Actions ~

View All Site Content
Sagsindhold
= Dokumenter

WORKSMART: Nyt samarbejdssystem for hele organisationen

Dokumenter Stamdata

New | ~| Upload =  Actions ~ Settings ~ i
= Emails [] voi o A edit

= Opgaver @:4

Document )Modified By Modified Select
Select a blank template for new office Emne WORKSMART: Nyt
document samarbejdssystem for hele

5] Recycle Bin
= organisationen
Folder d

Add a new folder to this document Emne ID CMS-2008-00009
library.

Status Under behandling
Send mail

Send mail from th d s Ansvarlig NCDMZ\mek
DETQDT:‘ZI macﬁzacﬁ f;?::; strs nt template configuration guide NCDMZ'\mek  24-09-2008 21:54  Internt notat O

Beskrivelse Her findes alt materialet og

Template Picker korrespondance med

Open the document template picker, leveranderer omkring
CatOrnanized - o tn st i NCDMZ\mek  24-09-2008 21:54  Intentnnt=t ™ T S & U

[+ Inbox in Persanal Folders - Microsoft Qutlook

it Options  Format Test ) NCDMZynek  24-09-2008 21:55  INtermt ; mie gyt view Go Iools Acions Help

AT \ b cu s -[u - [WX[EEE (B8] @ o8 & L ' ; ware | BB W | G | B senameceee -
5404 o Veanart Paste. . - iF 8 Agdress Check | Aftach Aftach Business Calendar Signature N Speling
agn Vet || O oot || (BT PO ] T )| Agcres coat | g pccn = oeing

GetOrganized
GetOrganized! Clipbosrd 3 BasicTest “l Hames Inciude | prosting trsender

Gem mail Subled

prere—
Gem emai g vedhasfteds filer /, I getorgan 'E?.g

ebastian W <swo@netcompany.
nne Holm <ah@devoteam.dk> e —
Wichael Ekegren, ——— \adr £A4€ I00% 6000
Facebook Qpen

B

©n the Insert tab, the gallerid\Indude items that are designed to coordinate with the overall look of your document. You can use these galleries ta insert tables, headers, = [ichael Ekegren <mek@netcompar ID: E v P m Windows IT P st
faoters, ists, cover pages, and Nher document building blocks. When you create pictures, charts, or diagrams, they alsa coordinate with your current document look, Lbastian W <swo@netcompan indowsir Pro =
You can easily change the formast\gfof selected text in the document text by choosing a look for the selacted text from the Quick Styles gallery on the Home tab. You can E PENY-9 Navm: WORKSMART: Nyt samarbeidssystem Far hele organisationsn Reply
also format text directly by using™Npther contrals on the Home tab. Most cantrals affer a choice of using the look from the current theme ar using a format that you specty esterday =
directly. & Bibliotek:  [Emaikl Replyto All
To change the overall laok of. lwick Style gallery, use the Change q "
Current Quick Style Setcome Tilfo] dokumenter til mail 1 _ [estore the look of your document to Muligheder: Udvaslg vedhesftads filer myhome T
the original contained in you  brug detre wndus t  veshaste dddamanter fa Gerorganzed  makn A getorganz Jesper Hoffmann
On the Insert tab, the galleri fleries 1 insert tables, headers, 5
On the inser 145, the gl alieries to insert tables, headers, Handiinger: Risteriet (Buti)
footers, lists, cover pages, ar your current document look. Follow Up
You can easlly change the foi| DotmentID ficntrais e gallery on the Home tab. You can @ Gem mail ped vedhasftelser (msg Format) edness o =
also format text directly by u Ine or using a format that you specify e : ednesday ategorize
aracty o £ C Gemn mail o udtrask vedhasftede Filer (txt Farmat + org. Fifermater) S ae

) —— 1 (CGem, udkrask 0g relater vedhasfteds Filer tl mail (=t Format + org. Fiformater) 55 Beaut-e-m3 Mark as Upread
Spies
) P Find Al
Med venlig hilsen/best regar ebastian Wojciechowski

Save Eortryd uesday Create Rule...
Michae| Ekegren Christanse

Manager Sharepaint Expe Junk E-mail

T T BilBasen medler|
Netcompany IT & Business C [ Produktivitets Delete

(21 daus@risteriet,
Gronningen 19 [ SRQO71213600420 - Search
DK-1270 Kabenhavn K ropice_|Inspcer o hr doment refeerc SRQVB0325600354 - My link

eoenfy [ ] 3 sRa YInkE 85 Date: Monday
[ SRQUE0723600339 - Send a
:l‘huljw\e ?:;?:115210::71 = [ 96 Subsaiptions (= ShareFoint
one: +

Fax: 4457013 1450 Bu a1 (130) 0 myhome

Win Dev Pro

View Attachments

Move to Folder...

Message Optians

Send to Onehlote

Gem mail

1= Date: Last Week
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Uformelle workflows — send dokument
som link og anvend facet plan til styring..

am sorte bokse 1 M

M |

=

4

|
X
=

Vis egenskaber
Rediger egenskaber

Administrer tiladelser

Rediger i Microsoft Office Waord

Slet

G4 til kildeelement
Send il

Tiekind

Slet udtjekning
Arbejdsprocesser

Giv mig besked

14-05-2008 11:36

Anden placering

Send et hyperlink med e-mail
Opret dokumentarbejdsomride
Hent en kopi

Opdater metadata
0g send dokument

Aben dokument via
email og opdater
metadata

-

(Dn) = 9 ¢
=)

- Message

. T

Insert

H Vil du kigge pa dette dokument? - Message (HTML)

Options

Format Text

Developer

Times New Rom —
F‘_g EETINE : B | B
aste
- F ¥-A-=

Clipboard ™

i=-||&E

Address Check

Book MNames
HNames

= =([%)

Basic Text F] Include

LZ'IA)\IA%‘] @@ Yv

Follow
Up~
Options

(==
!
Spe\lmg

"5 || Proofing

| I #® Michael Ekeagren;

_I |

Send

Subject: IV\I du kigge pd dette dokument?

20dekumenter/Lovi20forslag%20om%20sorte%20bokse.doc |

http://test08dk%2Encstest%2Enetcompany%%2Ecom/oversigt/sag%201/Delte%




Digitalen Collaboration sker ved brug af formelle
e eller uformelle workflows

 Formelle eller
uformelle workflows er
om MOSS kontrollerer
selve arbejdsgangen
eller om dokumentet

sendes fra bruger 1 til
bruger 2

B I
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Hooiagpym W

L/eElIle UUKUITIETILE]

Del et dokument med teamet ved at tilfgje det i dette dokumentbibliotek.

My = Send =  Handlinger ~ Indstilinger ~

Type Mawvn
IEIJ | Lov farslag om sorte bokse 1 Hy
Vis egenskaber
3 Rediger egenskaber
1;3 Administrer tilladelser
@ Rediger i Microsoft Office Word
K| slet
4"_1 G4 til kildeelement
Send til
—&I Tiek ud
(¥ Arbejdsprocesser

U ——
Home > Sagsoversigt > Sag 1 > Delte dokumenter = Lov forslag om sor

Arbejdsprocesser: Lov forslag om sorte

* Erug denne side til at starte en ny arbejdsproces pa det aktuelle element eller 4l at f2

Start en ny arbejdsproces

Start workflow Godkendelse
C" Distribuerer et dokument til godkendelse, Godkendere kan @
godkende eller afvise dokumentet, tildele
godkendelsesopgaven igen eller anmode om sendringer af
dokumentet.

B I

Arbejdsprocesser

Marker en arbejdsproces for at f3 yderligere oplysninger om den aktuelle status elle

Reageér pa workflow - Stertet Autet

Aktive arbejdsprocesser

Der er i gieblikket ikke nogen aktive arbejdsprocesser pd elementet,
Fuldferte arbejdsprocesser

Der er ikke nogen fuldfarte arbejdsprocesser pd elementet,
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Potingny W

o

File Edit Wiew Favorites Tools Help

Goog[e“(}v LIStart 4»5‘ - | ¢ Bogmasrker | ?Kontro\ler - BSend tilve @Indstilhngerv
iﬂ? ﬁ'ﬁ estart arbejdsproces | |
Home

§ifi sag 1

mmkumentcenher Seg

Home > Sagsoversigt > Sag 1 > Delte dokumenter > Lov forslag om sorte bokse = Arbejdsprocesser > Start arbejdsproces

5 v [ - f=h v sbPage v () Tods -

Velkommen Administrator ~ | Mit websted | Mine hyperlinks ~ d

Start "Godkendelse": Lov forslag om sorte bokse

Anmod om godkendelse

Huis du vil anmode om godkendelse af dette dokument, skal du indtaste navnene pd de brugere, der skal godkende det, p8 linjen

Godkendere. Hver bruger bliver tildelt en opgave vedrgrende at godkende dokumentet. Du modtager en e-mail, ndr anmodningen sendes,
og nér hver af brugerne har fuldfart opgaven.

Tilfgj navne pé godkendere i den raskkefglge, opgaverne skal tideles:

EL! Godkendere. .. | mek &I

r Tildel en enkelt opgave til hver angivet gruppe (udvid ikke grupper).

Skriv en meddelelse, der skal medtages i anmodningen:
Hej Michael

Vil du godkende dette dokument?

mvh

Forfaldsdato

Huvis der er angivet en udlgbsdato, og e-mail er aktiveret p& serveren, modtager godkendere en pdmindelse p8 den pgeeldende dato, hvis
deres opgave ikke er udfert,

Giv hver person falgends meengde tid til at udfere deres opgave:
IDag(e) VI

Giv andre besked

Huvis du vil give andre brugere besked om, at arbejdsprocessen starter, uden at tildele opgaver, skal du indtaste navnene pd linjen Ce.

gllce... | &I

Start | Annuller |

l_l_ ’_ l_ ’_ m@ Internet
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wersigt = Sag 1 = Delte dokumenter

okumenter

1t med teamet ved at tilfaje det i dette dokumentbibliotek.

d = Handlinger - Indstilinger - Visning:  Alle dokumen

AEndret ) Fndret af Godkendelse

rslag om sorte bokse !y 14-05-2008 11:31 Administrator

]

/DD lg L L] ﬁ @ B Lov forslag om sorte bokse.doc [Read-Only) [Compatibility Mode] - Microsoft Word -8 X

Home Insert Page Layout References Mailings Review View Developer Add-Ins @

i _=| Calior RSN RS =--*Ilf-§ flfllillil psBbced| AaBb( AaBbc A B

L3

Paste f |B I U ~abe %, x* Aa~||® - A -| |_ TMormal | Headingl Heading2 - (S::yalnge Editing
- e~ -

Clipboard ™ Font ] Faragraph Styles ]

L
/. Workflow Task Godkend Lov forslag om sorte bokse Edit this task...
T —
Document Managenment

S5ag 1l

Open site in browser
overzll look of your document. You can use thase galleries to insart tables, hazsders,

-
)
footers, lists, cover pages, and other document building blocks. Whenyou creste

pictures, charts, or dizgrams, they 2lso coordinste with yvour cumrentdocument look. This tab lists important status information
ahout the rurrent dorument. There is no

On the Insert tab, the galleries include itemsthat are designed to coordinate with the
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Approval Requested

From: Administrator

Due by:

Hej Michael

Vil du godkende dette dokument?

mvh

Type comments to incude with your response:

Formelle

workflows (4/4)

Status for arbejdsproces - Microsoft Internet Explorer provided by Netcompany
Godkend Lo¥ forslag om sorte bokse

ilﬂ pany.comJ‘oversigt,l’sag?-'bZDl,l’_\ayouts,l’erStat.aspx?List=°.-"o?b9E1C5266°.-"02dFEA2°f’ozj LR IGoogIe

t+ﬁ - | €9 Bogmarkery | P Kontroler ~ |ep Sendtiv (L) Indstillinger =

@ B vgggvlﬁvgagev@'rgolsv

ele]

Ret e helt T orden! Hermed godkendt!

arbejdsproces

l: 14-05-2008 11:58

Other options
Reassign task Reguest a change

Reject

Cancel

Hkend Lov forslag om sorte bokse 1 M

ristorik

rapporter

De falgende handelser er opstiet i denne arbejdsproces.

14-05-2008 11:50 Arbejdsproces Administrator
startet

14-05-2008 11:50 Opgave oprettet Administrator
14-05-2008 11:50 Fejl Systemkonto

14-05-2008 11:58 Opgave fuldfert Administrator
14-05-2008 11:58 Arbejdsproces Administrator
fuldfiart

14-05-2008 11:58 Fejl Systemkonto

rzigt > Sag 1 > Delte dokumenter > Status for arbejdsproces

I arbejdsproces: Godkendelse

Administrator Dokument: Lov forslag om sorte bokse
14-05-2008 11:50 Status: Godkendt

ver er blevet tildelt deltagerne i denne arbejdsproces. Kik pd en opgave for at redigere den. Du kan ogsd se disse opgaver pd listen Opgaver.

Velkommen Administrator ~ | Mit websted | Mine hyperlinks ~ @ ;I

Webstedshandlinger ~

Udfart Godkendt af Administrator

Godkendelse blev startet. Deltagere: mek

Opgave oprettet for mek. Forfalder senest: Ingen

The e-mail message cannot be sent. Make sure
the outgoing e-mail settings for the server are
configured correctly.

Opgaven, der er tidelt mek, blev godkendt af Godkendt af Administrator
Administrator, Kommentarer: Det er helt T orden!
Hermed godkendt!

Godkendelse blev fuldfert. Godkendelse pd Lov forslag om sorte bokse
er fuldfart. Alle deltagere har fuldfart
deres opgaver.

The e-mail message cannot be sent. Make sure
the outgoing e-mail settings for the server are
configured correctly.

’— ’_ ,_ l_ l_ m |,/ Trusted sites &, 100%
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sindstillinger - Microsoft Internet Explorer provided by Metcompany

FEX |

o)y x| B

File Edt VMiew Faworites Tools Help

@ L e |E http:ffgetorganizedfemnesagerf_layoutsfCaselpp/CaseType/AuditSettings, aspx

Co gie‘gv

T:? {Qf [@Overvggnlngs\ndstl\llnger

[

..| Spg 4 - \g] -‘ 9% Bogmarker~  [QL Find + " Kontroller + ] AutoFyld ~

& -

- »
s v |skPage + (O Tooks +

(logind ~

Opret

fi- B Faj et nyt bibliotek, en ny liste eller en

Startside > Emne Sager

/,I getorganized Emne Sager

Startside  Dokumentcenter  Sgg

Organiseringer -~

Hizelp og vejledning  temp

Overvagningsindstillinger

velkommen Systemkonto ~ | Mit websted | Mine hyperlinks + ) ny I'."IEbSIdE tll I'."IEbStEdEt'

Rediger side
Tilfaj, fjern eller opdater webdele pd
siden,

anized -

dard sva

Webstedshandlinger ~

Indstillinger for websted

ofil Administrer webstedsindstilinger p&

Thvexy
ndstl§ Alle emine sager
= Inds

orgal
= Defir

= Defir]
og si

Emne sagens forside
Emne sagens indhold
= Alle dokumnenter

= Akter

= Under udarbejdelse

= Sags|

Akter

Type Mavn

Vedr, deres
henvendelse
(ref EM5-
20059-00002) T
01302009
095111

b

Dok ID
230 2

AktID

= Opgaver

= Interessenter

Handlinger

» Owerfgr mails

= Jpret opgave

= Opretinteressent

= Send mail

= Giv adgang

2] Papirkurv

Abonnér

iz egenskaber
Fediger egenskaber
Administrer tilladelser
slet

Send i

Tiek ud
Versionshistorik
Administrer bilag

Flyt f kopier

Marker zom endelig
Journaliser

Se overvagningsrapport

Giv mig besked

Udarbejdelse

Bges support

LIS

vige | denne wvisnin

webstedet,

Angiv heendelsen, der skal overviges: 2= _
’ Se samlet overvdgningsrapport

Ebner rapport der viser haendelser

der er foretaget pd elementer i sagen
Systemkonto

Abring eller overfersel af dokumenter, visning af
elementer p& lister eller visning aF
elementegenskaber

Redigerer elementer

handler

Tiekker elementer ud eler ind

Flytter eller kapierer elementer til en anden

placering pé webstedet dnet ansvarlig

W2K3-GODEMOIMAG cc

Sletter eller gendanner elementer

Angiv heendzlsen, der skal overviges:
Redigerer indholdstyper og kalanner
Ssiger i webstedsindhald

Redigerer brugere og tilladelser

‘Webstedshandlinger ~

Anvend denne sige til at se overvdgnings log

J [ J [

[ Genopfrisk side Generer excel Fortryd

Element iD
06758752-9e64-4e88-94ef-dcfasfc44e 56

Location
cases/EMS [EMS-2009-00002/default. aspx

Bruger Hzendelse

Systemkonta

Element type Dato

Document 03-02-2009 10:50:08 View

Tips til audit logs og trimming:
http://www.johntimney.com/blog/Controlling+MOSS+Audit+Log+
Sizes.aspx
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genfindes eller gar det tilgeengeligt B
som HTML eller lign.

ElGEEC g TR v L ro v T

[ Startside | [ < il 00 veyedning  temp Webstedshandiinger - [JPY

Alle websteder  Personer | GetOrganized Sagning

GetOrganized - Sage webpart

sog: [ledelse

Find elementer fra...

Segescope Alle sager

5
Sagstype salg £

uddyb din segning...

Sagsegenskaber Dokumentegenskaber

Salgsmuligheds [0 Oprettet af 8
Kunde valg Havn

Fesstearior [ Guramied o e —

Samlger Dokumenttype | Tilbud

salgsmulighed Korrespondence [ Vazlg

=T

Status

T E_‘E | Ny virksomhedspraesentation + | 20-04-2009 15:17
e i)  Testpagel vis egenskaber 06-04-2009 16:36

Primar kontakt

Rediger egenskaber

Oprettet

Status bagrundslse

Administrer tilladelser
Estimeret lukkedato

Rediger i Microsoft Office Word

X 1B o 4l

Slet

Dokument 1D Titel Navn

s (B e s a0 ;
ot Vi egenskaber ST (1) Send til

% Re:uer :u:skaber Konverter dokument Fra Word-dokument il webside
3 Rediger dokument

Tiek ind
Slet udtjekning

Versionshistorik

Arbejdsprocesser

L @ ¢ o i

Flyt | kopier
Giv mig besked
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Hvad er ECM?
SharePoint sammenlignet med DMS systemer

Hvordan bliver min SharePoint et dokumenthandteringssystem?
— Hvad findes der af funktionalitet?
— Huvilke overvejelser og (informations) arkitektur skal man faglge — hvad er

best practice?

Udfordringen - hvor kan og bgr 3. parts produkter supplere
SharePoint lgsningen

Eksempel pa ECM lgsning i SharePoint
— Fokus pa capture, manage, storage, bevaring og publicering

Q&A
Referencer
Om Netcompany
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best practice?
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Eksempel pa ECM lgsning i SharePoint
— Fokus pa capture, manage, storage, bevaring og publicering

Q&A
Referencer
Om Netcompany




Digitalen Referencer

Forum for it-pro

Records Management:
— http://blogs.msdn.com/recman/archive/2006/07/28/681298.aspx

SharePoint Team blog:
— http://blogs.msdn.com/sharepoint/

AllM

— http://www.aiim.org.uk
GetOrganized

— http://lwww.getorganized.net
Document Conversion:

— http://www.sharepointblogs.com/zimmer/archive/2007/09/13/moss-
2007-configure-document-conversion-for-your-server.aspx
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best practice?
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— Fokus pa capture, manage, storage, bevaring og publicering

Q&A
Referencer
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* Netcompany leverer konsulentydelser inden for IT og forretning
* Netcompany deekker farende teknologier og standardpakker inden for Microsoft .NET og J2EE.

* Netcompany er dedikeret til "gamle dyder” med hgje professionelle standarder og fokus pa
lzsninger, der er bade teknisk og forretningsmaessigt beeredygtige for vores kunder

Dyb indsigt og erfaring inden for forretning, teknologi, integration, projektledelse, forankring og
brugervenlighed

Klientbase bestar primeert af veletablerede danske og internationale virksomheder/institutioner
Er 2005, 2006, 2007, 2008 karet af Bgrsen som Danmarks dygtigste IT virksomhed

Er i september 2005 udpeget af Microsoft Danmark som arets system integrator i Danmark

Er i september 2006 udpeget af Microsoft Danmark som arets Microsoft Dynamics CRM partner
Hgjeste kundetilfredshedsscore malt af Microsoft pd mere end 50 kunder i Danmark 2005/2006

Er tildelt 3 priser af Microsoft i 2008 for arets SOA leverandgr, CRM og Search Partner

« Vision

« At veere Danmarks fgrende og fortrukne leverandgr af forretningskritiske virksomhedssystemer,
integration og portaler pa Java J2EE og Microsoft .NET

* Etablereti 1999

+ 180+ medarbejdere




